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Message from the Director General of National Institute of Education

The General Education Transformative Reform Effort in Sri Lanka aims to create a 
decisive pathway to meet the needs of every learner. The foundation of this reform lies 
in the modernization of curricula, teaching–learning methodologies, and assessment 
systems, with a strong emphasis on competency-based learning, critical thinking, 
creativity, 21st-century skills, technological orientation, and ethical citizenship. 
 
The contribution of the Hon. Prime Minister; the Secretary to the Ministry of 
Education; Additional Secretaries; Subject Directors; the Commissioner General 
of Examinations and the staff; and the Commissioner General of the Educational 
Publications Department and the staff, who worked with exceptional dedication, 
has been immense in ensuring the quality of the curricula and related learning 
materials proposed for implementation from the year 2026 for  Grades 1 and 
6. These materials have been developed by the National Institute of Education 
through a collaborative dialogue with educationists, interdisciplinary experts, 
teachers, and various stakeholders.
 
I also gratefully acknowledge the exceptional commitment of the Council and 
the Academic Affairs Board of the National Institute of Education during this 
initiative. The entire staff of the National Institute of Education, who have 
contributed immenselyin accomplishing this task, deserve the respect of the 
nation.
 
Prof. Manjula Vithanapathirana
Director General
National Institute of Education
11.08.2025
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Message from the Commissioner General of Educational Publications

The world today is progressing at an exceptional pace, driven by innovation and 
transformation. In parallel, it is the paramount responsibility of everyone involved 
in the field of education to equip schoolchildren with the skills necessary to face 
the challenges of the modern world. Accordingly, must be noted with pride 
that the opportunity to introduce the module-based learning approach aligned 
with the new curriculum to be implemented from the year 2026 is a significant 
achievement.

These specially designed learning aids for each subject aim to strengthen essential 
skills such as critical thinking, creative problem-solving for complex issues, 
analyzing information from multiple perspectives, and making logical decisions. 
I believe these resources will serve as a strong foundation for each subject.

I kindly request all of you to use these learning aids as a guiding light to help 
realize the noble dreams of a generation of students enriched with wisdom 
and virtue. I also extend my heartfelt gratitude to everyone who contributed 
immensely to the excellent task of compiling the modules and activity books.

D. A. Subhashini Dematagoda 
Commissioner General of Educational Publications
Educational Publications Department, 
Isurupaya,
Battaramulla.
11.08.2025
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Foreword
Broad learning areas identified with regard to the total school curriculum reflect the 
ability of a nation to overcome the challenges emerging for sustainable development 
in a continuously changing country and a world.  Besides, broad learning areas 
need to be identified in synchrony with the demands changing from time to time.  
This not only modernizes the subjects in the prevailing school curriculum but 
also introduces new subjects to the school curriculum.  It is clear that learning 
teaching process too should develop timely corresponding to these changes taking 
place.  As a result of this, under the new curriculum that will be implemented with 
effect from 2026, learning - based modules have been introduced for every subject 
from grade 6 upwards.  For the primary grades and the junior secondary grades, 
it has been proposed to introduce the new curriculum as follows:  for grades 1 
and 6 in  2026, grades 2 and 7 in 2027, grades 3 and 8 in 2028, grades 4 and 9 in 
2029  and grades 5 in 2030. Modules containing new learning methodologies have 
been prepared from the junior secondary level and the teacher is expected to give 
guidance for the leaner.  The modules have also created the environment essential 
for self - learning It, is our belief that these modules are much helpful to develop 
strongly the knowledge on the concepts required for the students and their abilities 
and interests while directing them to apply the acquired knowledge to pragmatic 
situations. The learning transferred by these modules will also help strengthen the 
literacy, interpersonal relations and values necessary for the 21st century. 
                                     
Every module indicates the guide to use modern technology. They also will provide 
students assessment tools needed to evaluate transparently the performance and 
educational objections achieved by them. Always, every module is very important 
to give guidance for a real learning applying new talents and knowhow to applied 
situations.  I also wish to remind that the service rendered by the teachers, in- 
service advisers, directors as well as the contribution given by  the government 
and private institutions through respective fields helped  raise the quality of these 
modules. Further, I state that the suggestions made through the practical experience 
gained in the use of these modules are momentous and I respectfully  invite you 
are all it. 

K. Rajith Pathmasiri
Deputy Director General
Faculty of Science and Technology
08.08.2025
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Introduction

In today’s fast-paced, technology-driven environment, the need for ICT skills 

has become indispensable. This further learning module is crafted to enhance 

student’s abilities and skills by the end of grade 6, with a focus on preparing 

them for the demands of a rapidly evolving world. Each module includes tailored 

exercises and guides designed to ensure students’ understanding, alongside 

self-directed learning activities that accommodate different learning paces 

and schedules. This module can be followed by students who are interested in 

learning ICT and expanding their knowledge further. Collaborative learning is 

emphasized, encouraging students to work with peers to achieve their goals. The 

ultimate aim of this module is to equip students with the skills needed for success 

in the 21st century, carefully considering their individual needs and supporting 

their holistic development.

In addition, various websites and YouTube links are provided here to facilitate 

the completion of the activities and exercises included in this module, and to 

further enhance knowledge. I extend my heartfelt thanks to the respective content 

owners.

Mr. S. Shanmugalingam 
Director, Department of Information Technology 
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Further Learning Module 

Handling audio files is an essential part of the multimedia editing process, such 

as in animation and video production. Before editing, it is important to identify 

the different types of sounds included in the audio files. This module explains the 

process – from recognizing sounds to recording audio files and editing them by 

applying various quality enhancements. 
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Instructions to use the Modules 

	 This module is designed to help you, apply your basic knowledge of editing 
audio files and to develop practical skills in using audio software in everyday 
life.

	 Includes online searching activities and assignments to improve your skills 
and knowledge. 

	 Your teacher will guide you throughout the modules but it is your responsi-
bility to follow it yourself 

	 Completing given activities and assignments is very important as you will be 
assessed from the daily classroom activities and assignments 

	 You have to assess yourself and with peers on the performance of completing 
activities and assignments 

	 Be honest, impartial and accurate when assessing yourself and your peers 
	 At the end of a unit, the level of skills you have achieved will be evaluated 
by the teacher. 
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Learning outcomes

At the end of this module, you will be able to 
	 To use the various technical tools required for audio recording 
	 Understand how to setup a suitable environment for recording 
	 Practice ethical and moral behaviours at a recording location  
	 Record an audio clip using software 
	 Edit a recorded audio clip as needed 
	 Edit an imported audio clip as needed 
	 Export the recorded audio clips to various audio file formats 
	 Use shortcut keys to navigate an audio track 
	 Add additional audio segments to an audio file 
	 Import multiple audio files into an audio editing software 
	 Use different audio file formats 
	 Understand basic concepts such as audio, audio recording, 
audio clip, audio file format, audio track,  ethical behaviours 

	 Analyze the characteristics and significance of various 
environmental sounds in different contexts.

	 Evaluate the impact of computer-based entertainment on 
various aspects of daily life.  
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Dear Children, 

You have heard this song, haven’t you? Do you know that we can 
listen to this song, as they have been recorded and saved by using 
the technology?  

If you want to listen to that song you can use the following QR code 
or the youtube link 

       

Let’s Work with Audio files 
 

We are the world…. 
We are the children… 

Song by – “USA for Africa” Music Team 

https://www.youtube.com/watch?v=O6cE4DJUb_o

This website was last accessed on 2025-06-09

Scan This

Type This
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Do you know that we can record our own voices just like we recorded 
this song? In the same way, you can listen to the environment 
and record beautiful bird songs. It is not only just recording these 
sound clips, we can also use a computer to remove the unwanted 
parts in the recorded clip by using software, or record the required 
parts separately and make our soundtrack even more beautiful. 
 
Recording songs is also a complex process. In this module we will 
learn how to make a sound recording and make the necessary changes. 

	 QR (Quick Response) codes can be scanned with a QR 
scanner app and get the information embedded into them. In 
this process the web link of any video has been converted 
into a QR code. If your smart phone has internet access you 
will be able to access the data by scanning the QR code. 

	 You can access that information by typing the web link given 
below on the youtube search box. 

	 If you find any QR codes or URLs in this module, follow the 
above method to access them. 

Let’s see how is a song recorded in a studio.

https://www.youtube.com/watch?v=gwVduYHIayA

This website was last accessed on 2025-06-09

Do You Know?
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Let’s Listen & be Sensitive to the 
Sound

Identifies various sounds in the environment.
 Performance Standard

‘Sound’ is a media component and we all are sensitive to the sounds. 
Have you heard the sound of the rain? The ‘ho’ ‘ho’ sound?  
But sons and daughters, have you ever listened sensitively to

	 Buzzing sound of bees, 
	 Flapping sound of the wings of birds, 
	 Roar of the waves of the sea, 
	 Rustling sound of trees with the 
blowing wind, 

	 Chirping of birds
Have you ever thought of listening to the sound of petals of a 
blossoming flower? Now train yourself to be sensitive to such 
sounds you hear in the environment. 

“Music is Organized Sound”
(Edgard Varese)
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AActivity 1'1

Sound was recorded for the first time in the history by Edouard-
Leon Scott de Martinville in the late 1850’s in Paris nearly two 
decades before Alexander Graham Bell’s first telephone call (1876).

Do You Know?

 

https://tinyurl.com/oldsoundrecord

For more information regarding the historic 
sound, scan the QR code or go to the following link. 

This website was last accessed on 2025-06-09

Discuss with your friends and make a list of any sounds you 
or your friends have heard in the normal day to day life and  
present it to the class.    

								        (25 minutes)
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Waveform

When an audio file is inserted into a software, it is displayed 
graphically as follows. We call it as the waveform. You can learn 
the scientific background of it in science subject in future grades. 

Do You Know?

Let’s Identify Audio Devices

Identifies the basic digital devices involved in sound recording.

 Performance Standard

Dear sons and daughters, do you know that whether a sound is 
produced naturally or artificially. We need various technological 
tools to record and listen to it using digital devices.  

With the help of an adult, observe the colour differences in the 
audio ports on a television.

Pre Preparation
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	 Group according to the teacher’s instructions.
	 Discuss about the audio devices given to your group by 

		  the teacher.
	 Discuss with your group and identify the audio devices 

		  which has given to you.
	 Connect that devices correctly to the computer with the 

		  help of the teacher 
	 Discuss the tasks of those devices among group members 
						      (25 minutes)

Activity 2.1

Activity 2.1.1

Identify the technical devices and state the function of each device 
given below

Name of the device/devices
..................................................................
..................................................................
..................................................................

Function 

..................................................................

..................................................................
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Activity 2.1.2

Name of the device/devices 
..................................................................
..................................................................

Name of the device/devices 

..................................................................

..................................................................

Function 
..................................................................
..................................................................

Function

..................................................................

..................................................................

Identify the colour of each sound port below, and select the correct 
device which has connected  to each port from the list and write 
it on the blanks.

(speaker/sound output, microphone, sound input) 

................................. .............................. ........................
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Self -Assessment 

Assessment Criteria: 
•	 Connect Audio Devices accurately.
Mark —˜symbol in the box infront of the tasks you can perform. 

Task —˜Symbol

1' I can select sound devices.

2' I can select different ports according to 
    its colour.

    

3' I can choose the correct device to 
    connect based on the colour of the 
    port.
4' I can name the sound devices. 

5' I can connect sound devices to the 
    correct ports on the computer. 

Number of —˜ symbols

Your marks ''''''''' $5

If total number of  —˜ symbols is 5 Excellent

If total number of  —˜ symbols is 4 Good

If total number of  —˜ symbols is 3 Close to the expected goal

If total number of  —˜ symbols is 2 Need improvement

Su
bj

ec
t C

on
te

nt
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Let’s Record  Sound.

Recording a simple audio clip using a sound editing software.

 Performance Standards

If you want to listen to a sound again and again, it needs to be 
recorded. In the old days,	
•  Cassette Tapes  
•  Gramophone Disks are used to record sound. 

Today, high quality digital recordings are being made, and in addition 
to recording equipment, support of the software is essential.

Audio recording devices 
      • Microphones 
      • Speakers 
      • Headsets/ Headphones

Figure 3.1- Cassette Figure 3.2 - Gramophone
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Pre-Preperation

Bring a written note of the following, to do the recordings for 
Activity 3.1  

	  a morning thought 
	  lyrics of the school song  
	  a message or a song 
	  an announcement 

Activity 3.1

Make a recording using a voice recorder/sound recorder 
software on the topic of your group related to following list 
and present it to the class.  

	 A poem in the text book
	 School Anthem to be played in the morning assembly a 
morning thought
	 A song/message to be played during the interval to the 
whole school
	 A school announcement 

								        (50 minutes) 



11 Further Learning Module

Voice Recorder apps - Several audio recording 

applications for the Android operating system

Do You Know?

	 Listen to the audio file again which you have recorded in 
activity 3.1 

	 According to that identify any mistakes in your recording. 
Then discuss how the environment should be prepared for 
a good sound recording and list down your suggestions

	 Make a list of ethics to follow in a recording studio
	 Present your group’s findings to the class. 

								        (50 minutes)

Activity 3.2
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For your knowledge

Recording with Voice Recorder/Sound Recorder 

You can open Voice Recorder/ Sound Recorder by searching 
one of those two names in the search box.

	 You can start recording by clicking on the following icon in the 
recorder interface. 

	 To pause (temporarily stop) the recording, you can use the Pause  
recording button.

	 To resume (restart after pause) the recording, you can use Resume 
button.

	 To finish recording, you can use the Stop recording button.

 Let’s identify the software that used in sound editing. 
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• To find where the recorded file is saved, Right click on the name 
of the recorded file and select ‘open file location’ from the menu. 

When recording a dialogue, try 
to record the dialogue with
different emotions and styles. 
Then it will have different 
meanings. 

  Ex - You can try to pronounce the phrase “I am hungry”      
	 impulsively, pleadingly and casually.
It is very important to prepare the environment properly for sound 
recording. When recording sound on a commercial scale, special 
recording studios are used. They are carefully designed to prevent 
external noise and create quiet space for high quality recordings. 
These studios are sound proofed and built using various technologies 
to control sound. They are equipped with high-tech microphones, a 
variety of sound recording machines, and a code of ethics that must 
be strictly adhered to the use of these studios. 

Figure 3.3 - Diffrent Emotions
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	 Adjust the environment to minimize the shortcomings 
identified in activity 3.2 

	 Re-record the audio file you recorded with your group in 
activity 3.1 and present it to the class.

  

Activity 3.3

(50 Minutes)

NASA has recorded the sound of the sun and adjusted it to the 
human auditory range. You can use the QR code below or the 
YouTube link given below to listen to that exclusive audio.

Do You Know?

‘shotgun’ microphone is normally used in the film industry. 

This website was last accessed on 2025-06-09 

https://youtu.be/CRu_hG3X3bI?si=Ld-x_yesFhSvanY5

Figure 3.4 - Shotgun microphone
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Self -Assessment 

Assessment Criteria:  Recording audio using sound editing      
software. 
Mark —˜symbol in the box infront of the tasks you can perform.

Tasks —˜     

Symbol
1' I can select suitable devices for 
    recording sound.
2' I can connect a suitable device to the 
    computer for sound recording.

3' I can record sound using the computer 
    and troubleshoot errors that occur. 

4' I can create a suitable environment for 
    Audio recording.
5' I can select suitable software to record 
    sound. 

Number of —˜ symbols

Your marks ''''''''' $5

Su
bj

ec
t C

on
te

nt

If total number of  —˜ symbols is 5 Excellent

If total number of  —˜ symbols is 4 Good

If total number of  —˜ symbols is 3 Close to the expected goal

If total number of  —˜ symbols is 2 Need improvement



Further Learning Module16

Lets Edit Audio.

Edits an imported sound clip using audio editing software.

Performance Standard

Audio files are created by recording sound or voice. The software 
used to create and edit these audio files using computers are named 
as audio editing software. 

Audio Editing Software

There are some free software programs that you can use to record 
and edit sound. 
•	 Audacity
•	 Power Sound Editor 	
•	 Music Editor Free
There is also commercial software like Adobe Audition.

Before recording, no matter how familiar you are with the message 
or subject, it should be clearly written down on paper. In other 
words, you must have a script. 

Do You Know?



17 Further Learning Module

	 Divide the class in to two groups 
	 First group, recite the received poem
	 The second group should listen to it carefully with their eyes 
closed.

	  While the first group is singing, other members of the group 
should make some slight sounds time to time. (According to 
Teacher’s instructions)   

	 At the end, the second group should state when they heard 
unwanted sounds during the first group’s singing.  

	 In the same way the second group should recite while the 
first group listens as in the earlier case. At the end the first 
group should state the unwanted noises heard during second 
group’s performance. 

				    			   (50 minutes)

Activity 4.1

For Your Knowledge

To edit audio clip,  you need to train your ears to be able to 
recognize unwanted sound(noise). This will help you easily 
identify and remove unwanted sounds and create a quality audio 
clip. 

Pre-preparations 

Prepare a suitable script to announce the changes of school periods 
and bring it to the class. (In your mother tongue and in English)
     Eg:  “This is the begining of the first period.” 
          —fï wdrïN jkafka m<uq ld,Éfþohhs˜

            “,g;NghJ Kjyhk; ghlNtis Muk;gkhfpd;wJ”
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	 Using audio editing software, create an audio clip in two 
languages informing that the period is over and the next 
period has started 

	 Play and listen to the audiotrack 
	 Save the recording in the computer 
	 Present your recording to the class 

						      (50 minutes)

Activity 4.2 

Answer the following questions in your exercise book. 
	 Why do we need to edit audio files? 
	  Name two Free and Open Source(FOSS) Audio Editing 
software. 

	 Name commercially available audio editing software.

Exercise 4.2.1

For Your Knowledge

Audio recording using Audacity 

	 Open Audacity software
	 Take New Layers  (  File → New ) 
	 File → Save Project  → Save Project



19 Further Learning Module

	 Record  
     Used to start the audio recording 

	 Stop  
	 Used to stop the recording or playing of an audio clip 

	 Pause 
      Used to  temporarily stop the recording or playing of an audio clip 
     by clicking on pause for the second time recording or playing of      	
     the clip will resume.

	 Play
	 Used to start playing the clip 

	 Skip to Start
	 Moves to the begining of the audio clip

	 Skip to Stop
	 Moves to the end of the audio clip 

To record sound using Audacity software, Transport Toolbar is used. 
It allows you to record, playback, control and move to the begining 
or end of the track. By saving through File → Save Project, a file will 
be created in audacity project format which can be opened only by 
Audacity software. The files saved in the (.aup) extension can be used 
for further editing. 
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Imagine that you have being asked to play only in the main 
language, as it takes longer to play an audio clip in several 
languages to switch periods. Remove a portion of an audio 
clip and create a quality audio file using audio editing software 

	 Open the audio file created in Activity 4.2 using the 
	 Audacity software. 

	 Run it and listen carefully. 
	 Instead of a bilingual announcement, keep only the 
announcement in your school’s main medium of instruction 
and remove the audio segment in the other language. 

	 Play your new audio track again after editing and listen 
	 carefully. 

	 Select a location to store the edited audio track, give it a 
	 suitable name, and store it on your computer.
								        (50 minutes)

Activity 4.3

For your knowledge

Let’s make work easier by using shortcut keys.

Spacebar key of the keyboard can be used as a shortcut key to 
play or stop the audio track. 
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	 To play from any place of the audio clip use the selection tool 
and click on the place you want to start and click on the play 
button. 

	 To move the cursor from left to right or right to left in the audio 
clip use left or right arrow keys of the keyboard. 

	 To select a section of the audio track, 
               Using mouse 
                  • Click on the point of start to select 
                  • Press on the hand sign that appears and pull to the end    
                     of the selection and release the mouse 

               Using Keyboard 
                  Use the shift key with right or left arrow keys to select  
                  the required portion of the soundtrack 

When listening, you can use the following keys to skip parts 
of the audio track  

	 To get the cursor one second backward you can use left arrow 
key or comma ( , ) key

	 To get the cursor one second forward you can use right arrow 
key or apostrophe ( , ) key.

	 To get the cursor five second backward you can use left arrow 
key with shift key or  comma key( , ) with shift key 

	 To get the cursor five second forward you can use right arrow 
key with shift key or apostrophe key( , ) with shift key 

	 You can use the following path to open a saved Audacity file,
      File  Open(Ctrl+O)
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	 Click at the begining of the part to be removed.
	 Keep pressing “Zoom in” until the information becomes visible.
	 While holding the shift key, click on the endpoint of the section 
you want to remove. 

	 Click “cut” tool in edit tool bar or use delete key on the 
keyboard. 

Removing a part of the audio track. 
	  First, select the Selection tool

	  Form groups according to the teacher’s instructions. 
	 Organize and sing the song in groups using the lyrics given to 
your group by your teacher.

	 Record it with audio editing software. 
	 In cases where the same part of the song is repeated, sing and 
record it only once. 

	 Play it and listen carefully. 
	 Identify where the same part of the song should be repeated. 
(Identify the relevant point of the waveform.) 

	 Copy the repetitive part of the song and place it in the 
appropriate places on the waveform. 

	 Save the newly created audio track.
	 Export the new audio track. 
	 Present the audio file created by your group to the class. 

							       (50 minutes)					   

Activity 4.4 
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For your knowledge 

Positioning the required parts of an audio file using copy and paste 
	 You can select and copy the desired part of the song using the 
edit toolbar or shortcut keys. ( Copy / Ctrl+C ) 

	 Click on the location in the waveform where you want to copy 
the relevant part of the song.

	 You can paste the desired part of the audio clip using the edit 
toolbar or shortcut keys. ( Paste / Ctrl+V) 

	 If part of the audio is not in the right position, select it and 
move it to the desired location. (Cut - Paste)

	 The shortcut key ctrl+x can be used to cut the audio clip. 

	 Import audio files of various file formats provided by the 
teacher into the audio editing software. 

	 List the file formats that can and cannot be imported into the 
audio editing software.

Activity 4.5 

 (50 minutes)

A file extension, or filename extension, is used to help identify file 
types on operating systems such as Microsoft Windows. Often this 
is followed by a dot (.) and two or three letters.

Do You Know?
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From the file formats listed below, select two audio file formats and 
write them in your exercise book. 

Activity 4.5.1

.pdf       	 doc     	 .mp3      	 .wmv
	

.pptx    	 . midi   	  . wave     	 .xlsx

For your knowledge

Importing an Audio clip 

	 File → Import → Audio → Select relevant audio file → Click 
open 

	 Open Audacity software drag and drop the audio file into that 
window

	 Drag and Drop the Audio file onto Audacity icon 
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	 Import the audio file provided to you into the audio editing 
software. 

	 Observe the waveform carefully. 
	 Listen to imported audio
	 Select a part of your audio track that is approximately 10 
seconds long.(Trim)

	 Test your new audio track. 
	 Save the new audio track.
	 Export the new audio track. 
	 Listen to the exported audio file.   

Activity 4.6

(50 minutes)

•	      

For your knowledge 

	  WAV, MP2, MP3, FLAC are several types of audio file formats. 
Audio files in these formats can be played using an audio 
playback software.  

	 You can export an audio file and listen to it using audio 
playback software. 

1.	 Select the desired section from the audio track. 
2.	 Then   Edit → Remove Special → Trim Audio 
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Export audio files. 

	 File → Export → Export Audio  
	 Select the location where the file will be stored and give it an 
appropriate name. 

	 Select the desired file format using ‘Save as type’ option. 
	 Click the save button.
	 Then using the Edit Metadata Tags dialog box, enter the details 
of the audio track and click ok.

Gradually reducing the volume of the final section of an audio 
file (Fade out)

	 Open the audio file you created with the audio editing software. 
	 Run it and listen carefully. 
	 Observe the waveform at the end of the audio track. 
	 Gradually lower the volume at the end of the audio track. (Fade out) 
	 Observe the changes in the wave. 
	 Play the audio track again and listen carefully. 
	 Save the new audio track. 
	 Export the new audio track.

For additional practical training 
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Gradually reducing the volume of the final section of an audio 
– (Fade out)

	 Move to the end of the audio track using the Skip to End tool. 
	 Zoom in until you see the last two or three seconds of the 
waveform. 

	 Click on the waveform about one or two seconds before the end 
of the track. 

	 Then Select → Region → Select from the point you clicked in 
step(3) to the end of the track. 

	 Then Effect  → Fade Out 

After Fade OutBefore Fade Out

Pre-preparation 

Clearly write down on a paper what you want to record (such as 
a song, a stanza) related to the topic you choose for the activity 
below.

For your knowledge 
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Under the supervision of the class teacher, prepare an appropriate 
audio file to support the school’s adminitrative activities. 

	 Create a unique audio clip for the school that can be played 
at the start of each school period. 

	 Create an educational audio clip that can be played during 
school interval or before school starts. 

	 Create an audio clip to assist in performing morning and 
evening   religious services/ sessions.  

Activity 4.7

(50 minutes)
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For your knowledge  

Create a new audio file by combining several audio Segments.
	 You can import mutiple audio files into the audio editing software 
at once.

                • File → Import → Audio →select the required files at once  
                 → click on the open button. 
                • Click on required files holding the Ctrl key
                • Click on required files holding the shift key. 

To add a new track, 
 Track → Add New→ Stereo Track. 
	 You can adjust the visible area of the audio tracks within one 
window as needed. 

	 The track control panel allows you to temporarily mute any 
unwanted audio tracks. 

	 The ‘Close’ option in the track control panel can be used to delete 
unwanted tacks. 
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 Adding effects to audio files.

	 Open the audio recording you created during the previous 
activities using the audio editing software, play it and listen 
carefully.   

	 Now add following effects in suitable locations in the audio 
track.  

	 o Fade In (begining of the audio clip) 
	 o Fade Out (end of the audio clip) 
	 o Speed (selected point in the middle of the sound track)
	 o Echo (selected point in the middle of the sound track)

	 Listen to the changes carefully and practice by adding some 
more effects. 

	 You can save the edited clip. 
	 You can export the new audio track.

Before adding effect After adding effect 
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Self - Assessment
Assessment Criteria: Connecting audio devices correctlly. 

Mark —˜symbol in the box infront of the tasks you can perform.

Tasks —˜ Symbol
1' I can identify unwanted sounds in an 
   audio clip.
2' I can store a recorded audio file and 
    replay it.
3' I can open an audio clip by selecting 
    an audio editing software. 
4' I can split an audio clip into segments 
    by using audio editing software.
5' I can import an audio file into audio 
    editing software. 
6' I can store an edited audio clip.

7' I can observe the waveform of an 
    audio clip and identify variations in 
    volume. 

Number of —˜ symbols
                                                                  Your marks ''''''''' $5

If total number of  —˜ symbols is 5 Excellent

If total number of  —˜ symbols is 4 Good

If total number of  —˜ symbols is 3 Close to the expected goal

If total number of  —˜ symbols is 2 Need improvement
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Basic Concepts Related to Computer Technology

Software
Software refers to a set of instructions, programs, 
or data used to operate computers and perform 
specific tasks. 

Audio Audio generally refers to sound, particularly as 
it is transmitted, recorded, or reproduced.

Record
To capture and store sound using a microphone 
and recording equipment (analog or digital), so 
it can be listened to or reproduced later.

Audio Editing 
Software

Audio editing software is computer software de-
signed to manipulate and modify digital audio 
files.

Audio File 
Formats

Audio file formats are ways of storing digital   
audio data. 
ex - MP3, WAV, AAC, FLAC, AIFF,...etc 

User Interface
A User Interface (UI) is the point of interaction 
between a user and a computer system, software, 
or application.

Import File
To import a file means to bring data or content 
from one file into another program, system, or 
document so that it can be used or processed.

Export File

To export a file means to save or convert data 
from a program into a specific file format so 
it can be used in another program, shared, or 
stored.
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Free and Open 
Source Software

Free and Open Source Software (FOSS) is 
software that anyone can use, change and share 
because its source code is open and freely 
available. 

Shortcut Key

Shortcut keys are combinations of keys on a 
computer keyboard that perform specific actions 
or commands, often faster than using a mouse or 
navigating through menus.
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